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This 2" tutorial includes practical introductory examples of the combined use of the following
programs:

k-SUBGROUPSMAG
MAGMODELIZE
MAGNETIC REP
Get_mirreps
MVISUALIZE

For other programs of the magnetic section see the 1st and 3" tutorials

1. Introduction

In this second tutorial, we shall practice with the tools of the magnetic
section of the BCS (k-SUBGROUPSMAG, MAGMODELIZE, MAGNETIC REP,
Get_mirreps, MVISUALIZE, etc.), which can be used for modeling a magnetic
structure, from some basic experimental information.

As auxiliary program we will also use MAGNEXT, which allows to
investigate the plausibility of the possible models according to the systematic
absences observed in the magnetic diffraction diagram.

Further information on these programs and the theory behind can be found
in [1,2,3]

2. k-SUBGROUPSMAG: Magnetic subgroups consistent with some given
propagation vector(s) or a supercell

k-SUBGROUPSMAG can be used to explore ALL possible magnetic
symmetries which are consistent with one or more observed propagation vectors.
After introducing the space group of the paramagnetic phase (parent space group),
the propagation vector(s), and the Wyckoff positions of the magnetic atoms, the
program provides all possible symmetries of the magnetic structure, as subgroups
of the parent gray group and shows their group-subgroup hierarchy. The
conjugacy classes of equivalent subgroups can also be obtained, and the irreps
compatible with each symmetry can be retrieved. Also the systematic absences
associated with each possible symmetry of the magnetic structure can be obtained.

The possible subgroups provided by the program can be filtered according to
different criteria, in particular the condition that the subgroups should correspond
to the action of an order parameter transforming according to one (or several)
specific irreducible representation(s) of the parent space group.

Through a link with the program MAGMODELIZE, if the parent paramagnetic
structure is introduced, models of the magnetic structures can be constructed
corresponding to the possible symmetries chosen by the user among the list of subgroups



provided by k-SUBGROUPSMAG. The models can be visualized, and/or exported as
magCIF files for further test, refinement or analysis. The magCIF file obtained for each of
the alternative magnetic structures can be used for refinement of the model in programs
like JANA2006 [3] or FULLPROF [4], or they can be introduced in the program
ISODISTORT [5] for mode analysis, or transformed with the structure -editor
STRCONVERT within the Bilbao server. These magCIF files can also be used for 3D
visualization with VESTA[6] or Jmol [7]. A direct link to the tool MVISUALIZE also allows
an online visualization with JSmol of the alternative models as they are constructed.

k-SUBGROUPSMAG can also be used in the background by the users of the
refinement program GSAS-II [8]. Through a direct online link with k-SUBGROUPSMAG,
GSAS-II retrieves the set of possible MSGs that may be relevant for the case under study,
and the modelling for each of them is then done directly by GSAS-IL

Example: BazNb2NiOo

The paramagnetic structure of BazNbzNiO9 (Lufaso, Chem. Mat. 16, 2148 (2004)
and Hwang et al., Phys. Rev. Lett. (2012) 109, 257205 ) can be summarized as:
(file: Ba3Nb2Ni09_parent.cif)

Space group: P-3m1 (N. 164)

Lattice parameters: 5.7550, 5.7550, 7.0656 90 90 120

Asymmetric unit:

Bal 0.33333 0.66667 0.66380

Ba2 0.00000 0.00000 0.00000

Ni1 0.00000 0.00000 0.50000

Nb2 0.33333 0.66667 0.17700

01 0.50000 0.00000 0.00000

02 0.16978 0.33960 0.32623

(The small occupancy mixing reported in the older reference is neglected)

Magnetic atom: Ni
Observed propagation vector: (1/3,1/3,1/2)

We will use k-SUBGROUPSMAG, MAGMODELIZE and other programs to explore
the possible magnetic orderings compatible with the observed propagation vector.
The exploration is done in a hierarchical way starting with those orderings having
as much symmetry as possible. Subsequently, the restriction to a single irrep will
also be introduced.

2.1 k-SUBGROUPSMAG without irreps

a) Open the main page of k-SUBGROUPSMAG, introduce the number of the
space group of the paramagnetic phase and the propagation vector, and
submit with the rest of options in their default values. A list of 25 possible
MSGs are obtained. The Ni atom lies on a special position, and some of the listed
symmetries may be irrelevant because they would force a zero magnetic moment
on the position of ALL Ni atoms. We shall first drop these irrelevant symmetries.

b) Go back to the main menu and clicking on “Wyckoff’ introduce the
Wyckoff position 1b occupied by the Ni atoms. This will filter the list of MSGs,



only leaving those that allow non-zero magnetic moments in ALL Ni sites. The list
of possible MSGs now reduces to 13, and some of the maximal MSGs are of quite
low symmetry (Figure 1).

There are however 4 additional possible MSGs for a magnetic ordering on
this site, not shown in the list, which would force SOME of the Ni atoms to have
zero magnetic moment. This can be seen by clicking on the button “more options”
and then choosing the option: “non-zero magnetic moment allowed at (at least)
SOME Wyckoff positions”. This will make increase the list to 17 different possible
MSGs. But we will first consider that the ordering of all Ni sites is more probable,
and we shall stick to the original 13 MSGs shown in Figure 1.
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Figure 1. List provided by k-SUBGROUPSMAG of all possible magnetic symmetries of a magnetic
ordering for a paramagnetic structure with space group P-3m1 and propagation vector
(1/3,1/3,1/2), if the magnetic atom is at the Wyckoff position 1b, and with the additional condition
that ALL magnetic atoms should be allowed to have non-zero magnetic moments. Only one
subgroup per conjugacy class is shown. By clicking on the button “conjugacy class” a list of all
distinct subgroups belonging to the conjugacy class is shown. The button “Get irreps” is a direct link
to the program Get_mirreps, which allows to obtain all the irreps of the parent space group that are
compatible with the listed subgroup of the gray parent group. The last column allows to choose
those symmetries that one wants to transmit to MAGMODELIZE for further analysis of the
corresponding magnetic structure models (as you will see in the steps below).

Each subgroup is defined by the MSG type indicated in the second column with its
BNS symbol and its BNS numerical label, and by the transformation to the standard



setting of this MSG, indicated in the third column. This transformation is
fundamental to define unambiguously the subgroup. As it happens here, different
subgroups can be of the same MSG type, and can only be distinguished by the
transformation to standard, which is necessarily different.

The transformation (P,p) listed for each subgroup, where P is a 3x3 matrix and p =
(p1, p2, p3) a column vector, indicates in each case a choice of unit cell and origin, for which
the subgroup adquires the standard setting of the corresponding magnetic space group
(MSG) given by the MSG label, i.e. the symmetry operations of the subgroup would take
when described using this unit cell and origin, the form used for this MSG in the listings
taken as standard (you can use MGENPOS to see these listings). The transformation (P,p)
is defined with respect to the unit cell (ap,by,cp) and origin O, of the parent space group,
in the following form:

(as,bs,cs)= (ap,bp,cp).P , Os=0p+p1ap+p2bp+p3cy

where (as,bs,cs) and Os are the unit cell vectors and origin for a standard setting of the
MSG.

Note that we are using the convention of the International Tables for Crystallography and
the transformed basis vectors are the columns of the matrix. It is important to be aware of
this convention when comparing with other programs (like ISODISTORT), where the rows of
the matrix are the transformed basis vectors.

c) Click on the button “Get subgroup-graph” in the output page showing the
list of Figure 1. The hierarchical group-subgroup graph of the 13 possible MSGs,
as subgroups of the gray symmetry group P-3m11’ of the paramagnetic phase, is
then obtained (Figure 2):

Figure 2. Group-subgroup hierarchical graph of the MSGs listed in Figure 1, all of them subgroups
of the parent MSG P-3m11".



Figure 2 shows that the subgroup conjugacy classes numbered 1, 2, 3 and 7 are
maximal under these conditions (we called them k-maximal subgroups) and they
are the first candidates to explore in an eventual fit of experimental diffraction
data or in a DFT calculation, as empirically we know that symmetry tends to be
kept as high as possible. Two of these four possible k-maximal symmetries are
polar along the trigonal axis, and therefore correspond to a magnetic phase bound
to have some magnetically induced electric polarization (type II multiferroic). In
fact, the structure published for BasNb2NiOg (magndata #1.13) corresponds to one
of these polar k-maximal subgroups, namely P.31c.

d) Go back to the output page with the list shown in Figure 1, and in the last
column entitled “magnetic structure models” check the boxes corresponding
the mentioned k-maximal subgroups numbered 1,2 ,3 and 7; and also at the
bottom of the page, check “include structure data of the parent phase”, and
submit to MAGMODELIZE. A first input page appears to introduce the structure of
the paramagnetic phase. Submit the cif file of the parent structure of BazNb2NiOo:
Ba3Nb2NiO9_parent.cif, or introduce it by hand using the data of the structure
listed above. In the next page, check the Ni atom as the only magnetic atom and
submit. The resulting output page is partially reproduced in Figure 3.

N Group (BNS) Transformation matrix |General positions Properties Magnetic structure
11 o 0 Systematic absences
-1 2 0 1 MAGNEXT
1 Pc-31c (#163.84) ( o o 2 1/ z) Show T, Show
Tensor properties
Go to a subgroup MTENSOR
Alternatives (domain-related)
11 o0 7/3 Systematic absences
-1 2 0 8/3 MAGNEXT
2 Pc31c (#159.64) ( o 0 2 0 ) Show . Show
Tensor properties
Go to a subgroup MTENSOR
Alternatives (domain-related) _—
11 o0 7/3 Systematic absences
-1 2 o0 8/3 MAGNEXT
3 Pc31m (#157.56) ( 0 o0 2 0 ) Show . Show
e Tensor properties e
Go to a subgroup MTENSOR
Alternatives (domain-related) —_—
2 0 o0 0 Systematic absences
1 3 0 5/2 MAGNEXT
4 Cc2/m (#12.63) ( 0o 0 2 1/2 ) Show T Show
o Tensor properties o
Go to a subgroup MTENSOR
Alternatives (domain-related) .

Figure 3. Output page of MAGMODELIZE for the four subgroups of maximal symmetry introduced
directly from k-SUBGROUPSMAG.

The second symmetry in the list is the one that is realized in the structure reported
for BazNb;NiO9 and we will explore it first, but of course when investigating an
unknown structure we would go through all the listed subgroups and check which
one fits better our data.

e) Construct the magnetic structure corresponding to the second subgroup
on the list reproduced in Fig. 3, namely the one of type P.31c, by clicking on
“show” in the last column. The resulting output page (Figure 4) shows that the Ni
site remains unsplit, with a single symmetry-independent atom.

The unit cell and origin used by default for the description of the structure
(what we call "parent-like" setting) is indicated at the heading of the output
reproduced in Figure 4, giving its relation with the parent unit cell. This setting



(generally non-standard for the MSG) keeps the origin and also the unit cell
orientation of the parent/paramagnetic phase, but if necessary, multiplies the cell
parameters to produce a supercell consistent with the periodicity kept by the
propagation vector. At the heading of the list one can also find the transformation
from the parent unit cell and origin to the standard setting of the MSG, and one can
change the description to this setting, or to any arbitrary (but consistent) basis
chosen by the user. The output includes a list of the atoms of an asymmetric unit
(second column), the corresponding orbit of symmetry related atoms within the
defined unit cell (third column), the number of atoms of each orbit (fourth column),
the symmetry constraints of the magnetic moments for the representative
magnetic atoms in the asymmetric unit (fifth column), and a window to introduce
by hand any value for the free components of the magnetic moments (sixth
column). One can see in this output, partially reproduced in Figure 4 that the Ni
spin has two free parameters, with the spin direction of the independent Ni atom
on the xy plane being symmetry dictated, but having an additional free z
component. Let us assume for the moment that this z spin component is zero.

Magnetic Structure

Selected magnetic space group: 2- P;31c (#159.64)
Setting parent-like (3a, 3b, 2c ; 0, 0, 0)
Parent space group 164 (P-3m1)
Lattice parameters: a=17.26500, b=17.26500, c=14.13120, alpha=90.00, beta=90.00, gamma=120.00
[Go to setting standard (a-b, a+2b, 2c ; 7/3, 8/3, 0)]
[Go to an alternative setting]

Export data to MCIF file/Visualize Go to a subgroup

Atomic positions, Wyckoff positions and Magnetic Moments

N o ' ¥ yr er o ' ¥ ¥y “r
2| Ba2Ba %%%%%%0'00000 (1/3,1/3,0 | -my,my,m;) (1/3,1/3,1/2 | my,-my,-my) 18 - -
(1/3,2/3,0 | 2my,my,m,) (1/3,2/3,1/2 | -2m,,-my,-m)
(213,0,0 | -my,my,m;) (2/3,0,1/2 | my,-my,-m)
(2/3,1/3,0 | 2my,my,my) (2/3,1/3,1/2 | -2my,-my,-mz)
(2/3,2/13,0 | -my,-2my,mz) (2/13,2/3,1/2 | my,2my,-mz)

(0,0,1/4 | 2my,my,m;) (0,0,3/4 | -2my,-my,-m;)
(0,1/3,1/4 | -my,-2my,m;) (0,1/3,3/4 | my,2my,-mz)
(0,2/3,1/4 | -my,my,m;) (0,2/3,3/4 | my,-my,-m;)

o (1/3,0,1/4 | -my,-2my,m;) (1/3,0,3/4 | my,2my,-m;)
3| NitNi oboggggoo.ooooo (1/3,113,1/4 | -my,my,my) (1/3,1/3,3/4 | my,-my,-my) 18 (2My,My,M;)
' (1/3,2/3,1/4 | 2my,my,m;) (1/3,2/3,3/4 | -2my,-my,-m;)
(2/3,0,1/4 | -my,my,m;) (2/3,0,3/4 | my,-my,-m;)
(2/3,1/13,1/4 | 2my,my,my) (2/3,1/3,3/4 | -2my,-my,-m;)
(2/3,2/3,1/4 | -my,-2my,m;) (2/3,2/3,3/4 | my,2my,-m;)

My = 0.00000
M; = 0.00000

Figure 4. Partial view of the output of MAGMODELIZE describing the magnetic structure under the
subgroup of type P.31c listed in Figure 10, as obtained when clicking in the column "Magnetic
structure”. The table indicates the positions and moments corresponding to all atoms that are
symmetry related with the one listed as representative in the asymmetric unit (all described in the
parent-like setting described in the text). The number of symmetry related atoms within the used
unit cell (multiplicity) is given in the fourth column. The fifth column indicates the symmetry
restrictions on the value of the components of the magnetic moment for the representative
magnetic atom listed in the second colum (if any), while the last column on the right allows to
introduce specific values for the symmetry-free moment components.



f) Write a non-zero arbitrary value of 1 (Bohr magnetons) for the y
component of the Ni magnetic moment, and keep m; zero. Click then on
“Export data to MCIF file/Visualize”. A magCIF file of the model is then created,
which is shown on a non-editable window. Save the magCIF file by clicking on
“bes_file.mcif”, giving it an appropriate name, say P_c3cl.mcif. Inspect the text of
the magCIF file and locate the place where the transformation to the standard
setting from the one used in the file is indicated. You can see that this
transformation is:

(1/3a-1/3b, 1/3a+2/3b, c; 7/9, 8/9, 0)

Compare with the transformation to standard given in the output page obtained in
step d) (see Figure 3). Why are they different? What is the relation between the
two transformations?

g) Click on the button “submit to MVISUALIZE” to visualize the structure
online with JSmol, using the MVISUALIZE tool. This transmits the magCIF
directly to the program MVISUALIZE. On the next webpage that appears, use the
button “toggle parent cell” to visualize simultaneously the parent unit cell, and the
one that is being used in the description given in the magCIF file. (Figure 5).

Figure 5. Representation of the magnetic structure with symmetry P.31c (a-b, a+2b, ¢; 7/3,8/3,0)
assuming a null value of the allowed z-component of the Ni spin, as obtained with MVISUALIZE, and
showing both the parent unit cell and the one of the parent-like setting used.

h) Use the button “toggle standard” to visualize the standard unit cell
proposed by the transformation indicated in the magCIF file. (Figure 6).
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Figure 6. Representation of the magnetic structure with symmetry P.31c as obtained with
MVISUALIZE, and showing both the standard unit cell indicated in the magCIF file and the one of
the parent-like setting used.

i) In the button-menu entitled “select cell”, select “standard cell” to visualize
the structure using the standard unit cell proposed in the magCIF file (Figure
7). Explore the buttons that the page offers to control, edit, export, etc. the image. A
complementary window to introduce any Jmol command is also available. In
addition, by right-clicking on the graphic window, a detailed Jmol menu is
unfolded, and in particular a console can be opened to manipulate the image.

cell=1/3a-1/3b,1/3a+2/3b,c;7/9,8/9,0

Figure 7. Representation of the magnetic structure with symmetry P.31c as obtained with
MVISUALIZE, using the standard unit cell indicated in the magCIF file.

j) Do analogous steps to e), f) and g) for the other three subgroups in the list
of Figure 3 to obtain magCIF files of the corresponding magnetic structures
and visualize them either with the direct link to MVISUALIZE, or loading the
corresponding magCIF files in Jmol or VESTA. (Figure 8)



P:31m P.-31c C2/m

Figure 8. Scheme of the magnetic structures with the indicated maximal symmetries listed in
Figure 3, as obtained with MVISUALIZE using the corresponding magCIF files created with
MAGMODELIZE. For the case of P.-31c and C.2/m, the Ni site splits into two symmetry independent
sites, each with a single free parameter, and they have been given arbitrary different values to
distinguish the two sites. In the case of P.31m, the single Ni site has only one free parameter, with
no z spin component allowed.

k) Go back to the output page of MAGMODELIZE with the four subgroups of
maximal symmetry, which was obtained in step d) and is shown in Figure 3,
and investigate the systematic absences for the four symmetries, using the
direct link to MAGNEXT.

When inspecting the output of this program for each subgroup one must
take into account that the used (h,k,1) indexing corresponds to the supercell with
which the magnetic structure is being described. On Figure 9, a partial view of the
output of MAGNEXT for the second subgroup in the list (P:31c) is shown. One can
see that that all reflections of type (0,0,1) will be absent. Notice that the absence of
the reflections on the c direction, however, should not be taken as a general
indication that the moments are along this direction.

Systematic Absences of the magnetic space group Pc37c (#159.64) in the setting (3a, 3b, 2c; 0, 0, 0) of
the parent space group P-3m1 (No. 164)

Values of h, k, I: h integer, k integer, | integer

Warning: h, k, | are referred to the parent-like setting
Systematic absences for general reflections (produced by centrings):

Diffraction vector type: (hkl) ->  Systematic absence: |=2norh +2k/=3n

Systematic absences for special reflections:

Diffraction vector type: (001) ->  Systematic absence: |any

For 1

n
[
-

]
(=]

F = (0,0,Fz)

[Show form of structure factor for every type of reflection]

Figure 9. Output of MAGNEXT for the subgroup of type P.31c when introduced directly with the
optional button available in the ouput of k-SUBGROUPSMAG (Figure 3).




Comparing with analogous outputs for the other three subgroups, you can
check that this systematic absence happens for the first three subgroups in the list,
while it does not exist in the monoclinic subgroup of type Cc2/m. This means that
the observation of reflections of type (0,0,]) would allow to discard these three
trigonal subgroups, and we would only be left with the monoclinic one as possible
k-maximal symmetry.

The systematic absence for general reflections (h,k,1), which is listed for all
the subgroups, is trivial in the sense that it is equivalent to the presence of the
propagation vector (1/3,1/3,1/2), if the reflections were indexed using the parent
unit cell. Here, the reciprocal unit cell of the supercell (3a,3b,2c) is being used for
the indexing, and then self-consistently, the MSG associated with the structure
introduces this general systematic absence, which reduces the reflections to those
that can be explained with the mentioned propagation vector.

1) Click on “Show form of structure factor for every type of reflection” at the
bottom of the output reproduced in Figure 9. Inspecting the resulting output,
derive that if the magnetic moments in the structure lie on the xy plane with no
component along z, then all reflections of type (h,-h,0), (h,0,0) and (0,k,0) should
be absent (a structure factor component can only be non-zero if there are spins in
the structure with some non-zero component in this direction, and you have to
consider that the diffraction vectors are expressed with respect to the reciprocal
unit cell, while the structure factor is expressed in the direct space unit cell basis) .

m) Load the magCIF file corresponding to the subgroup of type P.31c saved in
step f) in the program VESTA. Go in this program to Edit -> Edit Data ->
Structure Parameters. In the menu of symmetry independent atoms, delete
all atoms except the magnetic Ni site -> OK.

Then Edit -> Vectors -> Click on the list Ni site and on the listed vector, and
click on “set”. This will recover the correct assignment of the vector describing
the spin of the Ni site, which has been lost through the deleting of the preceding
atoms. You can save the image that you have obtained for instance as .png using
File -> Export Raster Image. Compare the view of the structure that you have
obtained with the one that is available in MAGNDATA for the reported structure
and it is reproduced in Figure 10. The arrangement is different, but is it
equivalent?

Figure 10: Magnetic structure of BazNb;NiO¢ (only Ni
atoms), according to Hwang et al., Phys. Rev. Lett. (2012)
109, 257205 (MAGNDATA #1.13).



n) Come back to the listing of subgroups that you obtained in step b) and is
reproduced in Figure 1 and inspect the subgroup index of the relevant
subgroup for your structure. This index is listed as 6x2. This means that the
lattice and the point group are decreased by a factor 6 and 2 in the magnetic
ordering, respectively, such that the number of operations in the subgroup is 12
times smaller. This means that we should expect 12 different domains, i.e. 12
different but equivalent arrangement of the structure, obtained by applying to the
structure 12 lost symmetry operations. Those obtained by just applying time
reversal, i.e. by flipping all spins, are trivial, and therefore we are left with 6
different distinct forms to describe the structure, which are equivalent.

The final question in the previous step is then to decide if the spin
arrangement shown in Figure 5, and the one in Figure 10 are domain-related and
therefore equivalent. One can intuitively be convinced that it is the case, but one
should do it rigorously (in many cases, arrangements that look similar are not
equivalent!). A rigorous verification is done by just checking that the two
structures can be related by a lost operation of the parent group.

For this kind of problems we can use MVISUALIZE as a standalone program
to enumerate and construct all distinct equivalent domain-related forms of
describing the structure. We shall do this in the following steps.

0) Go to the program MVISUALIZE and upload the magCIF file saved in step f)
corresponding to the subgroup P.31c, and shown in Figure 5. The program
then shows a page with an image of the uploaded structure. On the left click on
the button “domain-related equivalent structures”. The resulting output page
shows at the bottom the list of 6 possible domain-related equivalent structures
(Figure 11). For each structure a lost operation (coset representative) is given.
This operation relates the domain-related structure of this row with the first one
in the list, which is the one of the input magCIF file. The six additional trivial
domain-related structures, obtained by the application of time reversal (spin flip)
to those listed, are not included in this list.



Domain-related equivalent structures: coset representatives and conjugated subgroups

The transformation matrices of the table are from the parent space group to the standard setting of the listed magnetic space groups
The coset representatives used to derive the domain-related equivalent structures are expressed in the setting of the parent group

Coset tati 1
| ose represt.en |ve? Transformation matrix Magnetic
(x,y,z) form Seitz notation Structure

1 0 7/3
1 X,y,2,+1 {110} -1 2 0 8/3) Show
0 2

Show

|

i
oNn
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©
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2 | x+lyz+1 | {1]100}
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5 | xy-y-z+1 | {2100]0} Show
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(
(
(
4 | yxz+l | {21010} ( ; z
(
(

6 |-x,-x+y,z,+1| {2010/0}

Figure 11. Partial output of MVISUALIZE when using the option “domain-related equivalent
decriptions” for the structure construted in step f) and shown in Figure 5 . The six equivalent
domain-related structures are listed together with an operation that transforms it into the input
one (the first one).

p) Click on “show” for the 3rd case in the list shown in Figure 11. The resulting
output page shows the structure related with the first one by the application of the
lost lattice translation (1,1,0). The output allows to download a magCIF of this
equivalent transformed structure, visualize it, transform it to the standard setting,
change it to any setting, etc.

q) Click on “Visualize” on the output page obtained in the previous step and
compare the view of the structure with the one that is available in MAGNDATA for
the reported structure and reproduced in figure 10. Check that they are the same
structure. Note that this identification of the MSG of the structure means that the
symmetry of the structure reported for BasNb2NiOg has a free z component for the
moment of the symmetry independent Ni atom. This means that in this phase a
spin canting along z is possible.

(If you have been very quick with the previous steps, you can try to imagine
and/or produce using this program the images of the other four possible domain
equivalent descriptions of the structure. Otherwise, go to the next step).

2.2. k-SUBGROUPSMAG with irreps

Up to now we have only made use of the condition that the MSG describing
the symmetry of the magnetic structure should be a subgroup of the gray group
P-3m11’, and must be consistent with the observation of (1/3,1/3,1/2) as single
propagation vector. We have shown that for this example the structure that has
been reported can be obtained by just looking at the four possible models of



maximal symmetry, which are compatible with the observed propagation vector
(k-maximal subgroups). We have also obtained that this experimental structure
can have a canting of the spins along the z direction, as it is perfectly compatible
with its MSG.

But k-SUBGROUPSMAG can also introduce the additional filter that the
investigated symmetry break should be the result of a spin arrangement according
to one (or more) specific irrep(s). We will continue practicing these options with
the same example.

r) Go back to the main input page of k-SUBGROUPSMAG obtained in step b)
and in the option “choose irreps” click on “representations”. The program
provides then an output page with the irrep decomposition of the magnetic
representation for the Wyckoff site 1b (Figure 12) (it uses the result of the output
of the program MAGNETIC REP, also in the Bilbao server, which can be used as a
standalone program for decomposing the magnetic representation into irreps for
any paramagnetic parent group and any Wyckoff position)

Space group of the paramagnetic phase: P3m1 (No. 164)
Choose the irreducible representation(s) for each propagation vector

If no Wyckoff position has been given, a general position will be assumed

Non bolded irreps are incompatible with the given Wyckoff positions
Bolded irreps are compatible with at least one given Wyckoff position
Red colored irreps are compatible with all the Wyckoff positions given

Possible magnetic irreducible representations

Wave-vectors of the star (2 vectors):

H:(1/3,1/3,1/2),(-1/3,-1/3,-1/2)

Descomposition of the magnetic representation(s) into irreps.

1b:(0,0,1/2) — 1xmH1(1) @ 1xmH3(2)

Choose the representation(s)

irreps: mH1(1)  mH2(1) 'mH3(2)

(In parentheses, the dimensions of the irreducible representations of the little group of k)

Submit

Figure 12. Irrep decomposition of the magnetic representation for the propagation vector
(1/3,1/3,1/2) and the site 1b, as given by k-SUBGROUPSMAG. The number in parenthesis after each
irrep indicate the dimension of the small irrep. As the irrep star has two vectors, a factor 2 relates
the dimension of each irrep with that of the corresponding small irrep.

The irrep labels in this output are those used in the ISOTROPY webpage, and one

can always inspect their matrix form by going to the program REPRESENTATIONS

SG (or also the program REPRES) in the section “Representations and Applications”
of the Bilbao Crystallographic Server, taking into account that the symbol m in the

irrep label only indicates that the irrep is odd for time reversal. One can see in the

output shown in Figure 12 that there are two possible irreps for the magnetic

ordering of the Ni site.

s) Check irrep mH1 and submit to include in the input the condition of the
magnetic ordering being according to this irrep. Submit the new input page.



The list and graph of possible MSGs for this irrep can then be obtained with only
three possible symmetries (Figures 13).

P.312
3

Graph made using Graphviz
Download a postscript file
Remove labels

Figure 13. Graph of the possible MSGs that can be realized by a magnetic ordering according to the
2-dim irrep mH1.

The two epikernels of mH1, of type P.-31c and P.-31m, shown in Figure 13 are two
of the six k-maximal subgroups in the list of 25 subgroups that were obtained
above in step a). The second one, P.-31m, forces a cero magnetic moment at some
of the Ni sites. This is the reason why this subgroup did not appear in step b).

A word of caution is obliged here: magnetic structures with some fraction of
the magnetic sites having zero average magnetic moments are less common, and
therefore one may consider them less probable to be realized, but there is no
reason to discard them beforehand, and magnetic structures of this type are also
reported (see for instance the structure of GdTi207 (magndata #1.56)).

t) Come back to the output page with the irrep decomposition of the
magnetic representation and check irrep mH3, instead of mH1. Submit to
produce a new input page with this second irrep. Submit the new input page.
The list and graph of possible MSGs that can be realized by a magnetic ordering
according to this irrep is then obtained. The large dimension of this irrep makes
that the number of possible distinct magnetic symmetries quite large, namely 14,
with 13 distinct irrep epikernels and the kernel. Six of the epikernels are maximal.
Some of these maximal subgroups split the 1b site, with some of the resulting split
sites being symmetry forced to have zero spin. These groups can be filtered and
discarded using the option that appears clicking the “more options” button and
then applying the option that limits the list of subgroups to those allowing non-
zero magnetic moment in ALL sites (Figure 14). The number of possible MSGs
reduces then to 11, and the number of maximal epikernels to 4.

One of the maximal epikernels of mH3 is the subgroup P.31c, which is the
symmetry of the reported structure of BasNbzNiOg (MAGNDATA #1.13). Hence,
mH3 can be considered the active irrep for the magnetic ordering of this
compound. This irrep describes the transformation properties of the 4-dim
primary order parameter responsible of this phase.
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Figure 14. Graph of the possible MSGs that can be realized by a magnetic ordering according to the
4-dim irrep mH3, with the additional restriction that the MSG should allow non-zero magnetic
moments at ALL sites derived from the Wyckoff positions 1b of the parent space group P-3m1.

Three of these maximal epikernels can be identified with three k-maximal
MSGs obtained in step c) shown in Figure 2. But the additional fourth maximal
epikernel in Figure 12, of type Cc2/c, is not a k-maximal subgroup. This means that
there must be at least a MSG consistent with the propagation vector, allowing
magnetic order at all Ni sites, which is a supergroup of this group of type Cc2/c.
This supergroup can be easily seen on Figure 2: it is the subgroup P.-31c, which
has been already investigated in step j).

v) Check the button “Get irreps” for the subgroup of type Cc2/c in the listing
of subgroups corresponding to Figure 14. The program then links directly to the
standalone program Get_mirreps, which provides for the pair parent group-
magnetic subgroup, the list of compatible irreps, and for each of them the required
irrep direction, and the corresponding isotropy subgroup. The resulting output
(Figure 15) shows that not only irrep mH3, but also the irrep mH1 is also
compatible with the group C.2/c.



List of physically irreducible representations and order parameters between a parent group and a given subgroup.

Input data

Transformation matrix

2 0 0 0
1 ) 0 -1/2
0 0 2 1/2

Group—subgroup

P3m11' (N. 164.86)—Cc2/c (N. 15.90)

Representations and order parameters

Show the graph of isotropy subgroups

isotropy subgroup
transformation matrix

P3m11' (No. 164.86)

k-vectors |irreps and order parameters link to the irreps

GM1™: (a) )
GM: (0,0,0) 2 af’(cr\'lo'o‘;g 59) matrices of the ireps
m 0. .
GMs": (a-(V32)) 2a+b,b,¢;0,0,0

. P31m1' (No. 162.74)
Ki: (aV3a) 2a+b,-a+b,c;1,0,0

K: (1/3,1/3,0) matrices of the ireps

: C2/mA’ (No. 12.59)
Ks: (2,03 2,0) 2a+b,3b,6,0,-1/2,0

P.3c1 (No. 165.96)

mA1~: (a) )
A: (0,0,1/2) a,b,2c,0,0,1/2 matrices of the irreps

- Cc2/c (No. 15.90)
mAg: (a.V33) 2a+b,b,2c;0,0,1/2

o Po31c (No. 163.84)
mH1: (@-(@3) a-b,a+2b,2¢;0,1,1/2
H: (1/3,1/3,1/2) matrices of the ireps

o Cc2/c (No. 15.90)
mHs: (2.0-(@/'3)0) 2a+b,3b,2;0,-1/2,1/2

Figure 15. Output of the program Get_mirreps obtained by clicking on the button “Get irreps” for
the epikernel of mH3 of type C.2/c.

As the magnetic representation of site 1b for the observed propagation vector
decomposes in the form (Figure 12):

1 mH1(1) + 1 mH3(2)

and the output reproduced in Figure 15 indicates a fixed direction within both
irrep spaces, a spin arrangement complying with the subgroup C.2/c, will have a
single degree of freedom corresponding to each irrep. mH3 is the primary irrep for
this symmetry, and the four irrep spin basis functions must be combined in a
specific form to produce this symmetry, leaving a single amplitude to fit. But this
MSG allows a second degree of freedom with the same propagation vector
according to mH1, as secondary irrep. The output in Figure 15 shows also that
irreps for the wave vector A: (0,0,1/2), are also symmetry compatible. This wave
vector is in fact associated with the third harmonic of the primary spin wave with
propagation vector (1/3,1/3,1/2). This means that secondary irreps
corresponding to a third harmonic (label A for the irreps) can be the symmetry of
additional coupled secondary spin waves in the C.2/c structure.

w) Go to the main menu of the magnetic section of the BCS, and click on the
program MAGNETIC REP at the end of the list, and on the appearing menu,
introduce the parent space group of our case: 164, and the propagation
vector: (0,0,%2) corresponding to the point A. In the next input page choose the



Wyckoff position of Ni. The program then provides the irrep decomposition of the
magnetic representation for this Wyckoff position and the wave vector A (0,0,1/2):

1mA1-(1) + 1 mA3-(2).

The output also indicates that the irrep star has only one vector, and therefore the
dimensions in parenthesis are the dimensions of the full irreps. Taking into
account the output reproduced in Figure 15, this means that a structure according
to the subgroup Cc.2/c will have 2 additional secondary parameters in their spin
arrangement corresponding to the irreps mA1l- and mA3-, which are allowed as
third harmonics of the primary mH3 spin ordering. The total number of spin
degrees of freedom is therefore 4, corresponding to four different irreps, and only
one of them corresponds to the primary 4-dim irrep mH3.

x) Submit to MAGMODELIZE the subgroup C.2/c in the list of subgroups
corresponding to Figure 14, using the option at the bottom of the list, and
introducing when required the parent structure of BazNb:NiOo, as done in
step d) and f) for other symmetries.

Check that the structure has indeed four free parameters for the spins. The
Ni site having split into two independent sites with four free components (Figure
16). In general, if we give to these four independent spin parameters arbitrary
values we are describing a structure where spin modes corresponding to the four
irreps mentioned above will be present. How can one correlate these four
parameters so that the resulting structure only involves the primary irrep mH3
and only a single parameter is free? This (unfortunately) is not provided by
MAGMODELIZE, which only produces the magnetic structure model under this
MSG with the four free parameters as spin components of the symmetry
independent sites. The decomposition of the four degrees of freedom in terms of
four spin basis functions, adapted to the four irreps, can be done using
ISODISTORT [5].

(Z70,270,U [ U,0,UT (270,270, TTZ [ U, 0,07

(0,0,1/4 | 2my,my,mz) (0,0,3/4 | -2my,-my,-mg)
(0,2/3,1/4 | 2my,my,my) (0,2/3,3/4 | -2my,-my,-my)
Ni1_1 Ni 0.00000 0.00000 (1/3,1/3,1/4 | 2my,my,mz) (1/3,1/3,3/4 | -2my,-my,-my)

0.25000 (113,2/3,1/4 | 2my,my,my) (1/3,2/3,3/4 | -2my,-my,-my)

(2/3,0,1/4 | 2my,my,my) (2/3,0,3/4 | -2my,-my,-mg)

(2/3,1/3,1/4 | 2my,my,my) (2/3,1/3,3/4 | -2my,-my,-my)

My = o0.00000

12 (2my,My,M;) M = 0.00000

(0,1/3,1/4 | 2my,my,my) (0,1/3,3/4 | -2my,-my,-m;)
(1/3,0,1/4 | 2my,my,my) (1/3,0,3/4 | -2my,-my,-m;) 6 (2My, My, M) M, =
(213,2/3,1/4 | 2my,my,m;) (2/3,2/3,3/4 | -2my,-my,-m;) 7 = 0.00000

Ni1_2 Ni 0.00000 0.33333
0.25000

My = 0.00000

(1/9,2/9,z | my,my,mz) (2/9,1/9,-z | -my,-my,-mz)
(1/9,2/9,z+1/2 | -my,-my,-my) (2/9,1/9,-z+1/2 | my,my,mz)

Figure 16. Partial view of the output of MAGMODELIZE for the epikernel of mH3 of type C.2/c, as
obtained when clicking in the column "Magnetic structure". One can see that the Ni atoms split into
two independent sites and four free parameters exist. An arbitrary set of values for the four
symmetry independent moment components implies however an uncontrolled combination of spin
modes corresponding to four different irreps (see text).

This is an example of the need of including both MSG and irreps constraints
if one wants to refine the structure in a controlled way: if only the traditional
representation method is employed and the refinement is restricted to the mH3
irrep, there will be four free parameters to refine as there are four independent
spin basis functions for this irrep, and the symmetry of the spin arrangement for



an arbitrary combination of these four basis functions to be refined would be the
minimal symmetry allowed by this irrep, i.e. the irrep kernel Ps1 (see Figure 14),
while if the structure is refined only using the crystallographic constraints of the
subgroup of type C.2/c, then again we have four free parameters to refine, but
they represent uncontrolled combinations of spin modes corresponding to the
irreps mH3, mH1, mA1- and mA3-.

If one wants to refine the structure under the condition that its symmetry is
Cc2/c and in addition that the magnetic ordering is restricted to the primary irrep
mH3, and therefore with a single parameter to refine, then one needs to consider
BOTH the symmetry constraints coming from the MSG and the additional
restrictions coming from the irrep mH3, restricted to the appropriate direction to
be compatible with the mentioned subgroup.

y) Click on the button “Get irreps” for the subgroup of type P.31c in the listing
of subgroups corresponding to Figure 14. From the resulting output and the
previous decompositions of the magnetic representation discussed in the previous
steps, derive that the magnetic structure will have two degrees of freedom for the
spin, and one of them corresponds to the secondary irrep mA1-. By looking at the
structure model corresponding to the subgroup of type Pc-31c, which was
obtained in step j) and the ouput of Get_mirreps for it, derive that the
decomposition of these two degrees of freedom into mH3 and mA1- components is
quite trivial: the xy spin correlated components of the independent Ni site
corresponds to the primary mH3 arrangement, restricted to the subgroup of type
Pc31c, while the symmetry-allowed z component correspons to the secondary
irrep mA1-, which is a third harmonic, which can appear through high order
couplings.

z) If you still have the mood for doing something else: go back to the output
page of MAGMODELIZE with the four subgroups of maximal symmetry, which
was obtained in step d) and is shown in Figure 3, and investigate the
differences on tensor properties for these four k-maximal symmetries, using
the direct link to MTENSOR [9].
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